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[About This User Guide]
This user guide provides all kinds of information about Gustec laser printer so that you can have a correct

knowledge and use it properly.

[Legal Explanation]

Trademark

 Microsoft Windows ®, Windows XP®,Windows Vista ®,Windows 7 ®,Windows 8 ®,Windows 8.1 ®,

Windows 10 ®, and Windows 2008 Server R2 ®, among others, are trademarks registered by Microsoft

Corporation in the United States and other countries.

 For the software names mentioned in this user guide, their ownership is by the respective companies in

accordance with the corresponding license agreement, and references to them are for illustrative purposes

only.

 Other product and brand names mentioned in this User Guide are registered trademarks, trademarks or

service marks of their corresponding owners and are referred to for illustrative purposes only.

Copyright

 This user guide is copyrighted by Gustec Corporation.

 Without prior written consent from Gustec Corporation, it is forbidden to copy, translate, modify and transmit

this user guide by any means or in any form.

Disclaimer

 Gustec Corporation reserves the right to make changes to this manual. The information in this user guide is

subject to change without notice. Any damage caused by the user's failure to follow the user guide shall be

borne by the user himself. At the same time, Gustec Company makes no express or implied warranties or

guarantees with respect to this manual (including formatting or text) other than those expressly stated in the

product repair manual or service commitment.

 Gustec Company shall not be liable for any changes (whether direct or indirect) arising from or related to the

use of this manual.

 When this product is used to copy, print, scan or otherwise form certain documents or images, it may violate

the laws of your location. If you cannot determine whether the use complies with the local law, please consult

a legal professional.



[Laws and Regulations]

 This symbol indicates that the product cannot be carelessly discarded with other waste materials.

 As a better practice, you should send waste equipment to designated collection points so that waste electrical

and electronic equipment can be recycled.

 This product is suitable for indoor use, not for outdoor use.

 This product is recommended for safe use in non-tropical areas.

 This product is recommended for safe use at an altitude of 2000 meters and below.



[Prompt Information]

Laser warning

 Do not operate or repair the printer with the protective cover of the laser/scanner assembly removed. While

the reflected beam is not visible, it can harm your eyes.

Energy-saving

 This machine adopts advanced energy-saving technology, which can reduce energy consumption when it is in

an inactive state. When the machine does not receive data for a period of time, the power consumption is

automatically reduced.

Recycle

 Please recycle or dispose of the packaging materials of this product in an environmentally responsible

manner.

[Statement]

 This is a Class A product, which may cause radio interference in living environments. In this case, it may be

necessary for users to take practical measures against such interference.



[Important Preventive Measures and Safety Information]
When using this machine, be sure to follow the following basic safety precautions to reduce
hazards such as fire, electric shock, and personal injury:
1 Read and understand all the instructions.
2 Understand common sense when operating electronic equipment.
3 Follow all warnings and instructions marked on the machine and on the accompanying text materials.
4 If the operation instructions conflict with the safety information, please pay attention to the safety information.
You may have misinterpreted the instructions. If you can't solve the conflict, please contact your sales
representative or service representative for assistance.

5 Before cleaning, unplug the machine from the AC wall socket or phone jack. Do not use liquid or aerosol
cleaners. You can only clean it with a damp cloth.

6 Do not place the machine on an unstable cart, shelf, or table. Otherwise, the machine can fall, which may cause
serious damage.
7 Do not place the machine on or above or near radiators, heaters, air conditioners or ventilators.
8 Do not place anything on the power supply. Do not place the machine where the power cord will be stepped on.
9 Do not overload wall sockets and extended wires. Otherwise it can lower the performance and may even cause a
fire or electric shock.
10 Do not let pets bite the power cord and PC interface cable.
11 Do not push anything into the machine through the enclosure or the opening of the enclosure. Because this
may touch a position with a dangerous voltage, causing fire or electric shock. Do not spill any liquid on or inside
the machine.
12Machines may come with heavy cover plates, which are designed to provide the right amount of pressure when
scanning/copying documents for best results (usually flat-panel machines). In this case, after placing the
document on the scanning glass, hold the cover plate and lower it gently until the cover plate is back in place.
13 To avoid the danger of electric shock, do not disassemble the machine. If repairs are required, please contact
professional technical service personnel. Opening or removing the cover plate can expose you to dangerous
voltages or other hazards. If it is not properly assembled, it may cause electric shocks during subsequent use of
the device.



14 Unplug the machine from the phone jack, PC, and AC wall socket and seek help from a service professional in
any of the following cases:
 Damage or wear to any part of the power cord, plug, or connecting cable.
 Liquid is sprinkled into the machine.
 The machine gets wet in rain or water.
 The machine still does not work properly after operation according to the instructions.
 The machine falls to the ground or its body is damaged.
 A sudden and noticeable change in the performance of the machine occurs.
15 Please adjust only the controls mentioned in the operation instructions. If other controls are adjusted
incorrectly, the machine may be damaged, and professional technical service personnel will need to work a lot to
get it back to normal work.
16 Avoid using the machine during thunderstorms. Lightning can cause lightning strike hazards. If possible,
unplug the power cord during a thunderstorm.
17 Due to the risk of damage to this product due to non-professional maintenance, Gustec strongly recommends
that repairs should be carried out by technicians trained by Gustec. When repairing the product or parts specified
in this user guide, the user must bear the risk of personal injury and damage to this product. Therefore, before
repairing, this repair manual must be carefully read so that this product can be operated and maintained correctly.
18 Keep this user guide properly.



[Laser Safety Statement]
Class I laser products are not dangerous. Laser systems and printers are designed to be subject to laser radiation
that does not exceed the standards specified in Class I under daily operation, user maintenance, or specified repair
conditions.
Laser radiation is harmful to human body. In order to avoid laser radiation, please do not dismantle the machine at
will!
The machine is equipped with Class IIIB laser diode, and there is no leakage of laser radiation in the laser
module. The laser assembly inside the machine is labeled as follows:

[Radio Frequency Radiation]
What users should know about the FCC:
This machine has been tested, demonstrating its compliance with the limitations of Part 15 of the FCC
Regulations for Class B digital equipment. These restrictions refer to the provision of reasonable protection
against harmful interference when installed in a residential environment. This product generates, uses and radiates
radio frequency energy that, if not installed and used as described in this manual, may cause harmful interference
to radio communications. However, we do not guarantee that there will be no harmful interference under certain
installation conditions. If this machine causes harmful interference to radio and television (which can be
determined by switchgear), the user can take one or more of the following measures to eliminate the interference:
 Adjust or relocate the receiving antenna.
 Increase the distance between the machine and the receiver.
 Connect the machine to a power outlet different from the one used by receiver.
 Consult with dealers and professional TV technicians for help.
Note: Any changes or modifications made by the user to the equipment without the express approval of the
manufacturer responsible for the conformity of the product will invalidate the equipment operation authorization.
This digital device does not exceed the Class B limit for radio noise emissions from digital devices specified in
the Jamming Equipment Standard entitled "Digital Apparatus" in the Canadian Industry and Science ICES-003
Standard.
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1. Basic Product Information

This chapter contains:

 Special features
 Component locations
 Consumables information



1.1.Special features

This laser printer uses a super large color touch LCD screen
 4.3-inch LCD screen
 Capacitive touch screen
 High-definition, super-large color

Excellent quality and extremely high speed printing
 Support 600DPI, 1200 DPI resolution printing
 Support single/double-sided printing

Flexible handling of paper
 The standard 250-page (70g/㎡) tray can support standard types and sizes of paper. In

addition, standard paper cassettes also support single sheets of special media
 The automatic paper cassette can also support single sheets of thick paper, tissue

paper, recycled paper, etc.

Capable of printing in various environments
 You can print using various operating systems such as Windows XP, Windows 7,

Windows 8, andWindows 10, as well as systems such as Linux
 Native USB interface
 RJ45 interface (standard wired interface) (optional)
 WiFi (standard wireless interface)(optional)
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1.2.Component locations

Front view

No. Name

1 Document Feeder (ADF)

2 Control panel (touch screen)

3 Paper Output Extension Holder (Paper Output Tray)

4 Automatic feed tray

5 Scanner

6 Power switch button

7 Front cover switch
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Rear view

No. Name

1 USB interface

2 RJ45 interface (standard wired network card interface) (optional)

3 Power cord interface

4 Nameplate

1.3. Consumables information

Picture

Description Toner cartridge for Gustec multi-functional laser machine
Print quantity
standard

Reference International Standard Printing Volume ISO/IEC 19752

Notes:

 The toner cartridge for the Gustec laser machine is a drum-powder one-piece toner
cartridge.

 The Company does not recommend the use of non-Gustec original consumables.

 Any damage caused by the use of non-Gustec original consumables is not covered by the
warranty.

 Models are subject to increase without prior notice.
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2. Printer Installation Steps

This chapter introduces the basic operations of the machine step by step.

This chapter contains:

 Check the machine and its accessories
 Installation position
 Installing the toner cartridge
 Paper feeding
 Establishing a connection
 Power on
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2.1.Check the machine and its accessories

Remove the machine and all accessories from the box. Verify that the following items are included in the
package:

The CD contains Gustec laser printer driver, scanning driver, Gustec scanning software, and user guide.

The appearance of a power cord may vary depending on the specifications in your area.

Name Picture

USB cable

Toner cartridge

Power cord

CD-ROM

Quick Installation Guide

“Three Guarantees” Voucher

Note:
 The power cord must be plugged into a grounded socket.

 Components may vary from region to region.
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2.2.Confirm the installation location of the machine

1. Remove the packaging bag of the wrapping machine and choose the appropriate installation location

according to the following criteria:
 Choose a position, such as a table top, that is level, firm, spacious, has good air circulation and is less

prone to vibration and impact.
 Leave plenty of room for opening the front lid and feed tray.
 Installation location should be well ventilated and away from direct sunlight or heat, cold and moisture

sources.
 Place the printer near a standard, grounded electrical outlet.
 Install the printer at a temperature between 10 °C and 32 °C and a relative humidity between 20% and

80%.

2. Leave clearance space
 Front: 300 mm (leaving plenty of room to open front lid and paper cassette)
 Rear: 150 mm (leaving enough room for connecting power and data cords, providing enough room for

air circulation)
 Left: 100 mm (enough room for air circulation)
 Right: 100 mm (enough room for air circulation)

Note:
 Do not place the printer on the edge of your desk or workbench. Components may vary

from region to region.
 Do not place the printer near heaters, refrigerators, air conditioners, fluids, or chemicals.
 Do not expose the printer to direct sunlight, overheating, humidity, or dusty places.
 Do not connect the printer to an outlet controlled by a wall switch or automatic timer.
 Do not connect the printer to an outlet that shares the same circuit as a high-powered

home appliance or other device that may cause a power outage. Avoid sources of
interference, such as speakers or cordless phone bases.

 While using the printer for a long time or printing a large number of folders in a room
with poor ventilation, please pay attention to maintaining indoor air circulation.

 Please connect the printer to a stable power supply. If the power is cut off, the
information in the device memory will be lost.
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2.3. Installing the toner cartridge

1. Open the front lid.

2. Remove the toner cartridge from the packaging bag, tear off the packaging tape and remove the wrapping

paper used to protect the toner cartridge.

3. Gently shake the toner cartridge 5 to 6 times to distribute the toner evenly. Shaking the toner cartridge fully
can ensure that the toner cartridge is used to the maximum extent.

Note:
 To prevent damage, do not expose the toner cartridge to a bright environment for a long

time.

 Do not touch the green section under the toner cartridge. To avoid touching this area, use

the handle on the toner cartridge.

 If you accidentally get the toner on your laundry, wipe it with a dry cloth and wash it with

cold water. Hot water can cause the toner to seep into the fabric of the garment.
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4. Pull the toner cartridge handle and hold it. Insert the toner cartridge into the machine until it snaps into

place.

A. If the machine display prompts "the toner cartridge is not installed in place", please open the front cover,

hold the toner cartridge handle and take it out.

B. Reinsert the toner cartridge into the machine until snapped into place and press the toner cartridge handle

down.

5. Close the front cover. Make sure the front cover is closed tightly. There may be printing errors if the cover

plate is not closed tightly.

Caution:
Please be careful when inserting or pulling out the toner cartridge, do not scratch the printer.
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2.4.Put in print media

Note:
The paper cassette can accommodate up to 250 sheets of 70 g/㎡ ordinary paper.

1. Remove the auto-feed tray.

2.Adjust the printer's slider (default A4 width) according to your paper size.
Pinch the paper guide and adjust to the edge of the paper width.
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3. Load the paper with the printing side up.

4. Put in the auto-feed tray.

5.Open the scanning component (hold the gap at the bottom of the screen and lift it up slightly).
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6. Pinch the paper output tray to pull it out to unfold (paper output extension holder).

Note:
Make sure all four corners of the paper in the tray are flat. Be careful not to load too much paper.
Too much paper will cause jams.
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2.5.Establish a connection

1. Connect the USB cable to the USB interface of the printer.

2. Plug one end of the power cord into the printer's AC socket and the other end into a well-grounded AC

outlet.

Connect to an AC socket (with grounding protection)
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2.6. Start the laser printer

1. Press the power switch to turn on the printer. "Starting, please wait..." appears on the machine display, and it
takes about 30 seconds to enter the main operation interface, indicating that the machine has started.

2. The paper-moving motor of the printer will conduct self-inspection of paper-moving, and the scanner will
conduct self-inspection of returning to its original position.

Note:

Please check that the cable has been connected correctly before turning on the machine.
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3. Paper and printing media

This chapter describes how to select a print medium.

This chapter contains:

 How to choose a print medium
 Paper specifications
 Paper usage principles
 Paper capacity
 Paper storage environment
 Special paper

-Heavy paper
-Label paper
-Sulfate paper
-File paper
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3.1.How to choose a print medium

This printer supports many different types of printing media, such as ordinary paper, thick paper, tissue
paper, recycled paper, etc. Factors such as paper production methods, weight, composition texture, and
humidity are important factors that affect the machine’s performance and output quality. Paper that does not
conform to the principles outlined in this User Guide can lead to poor printing quality, an increase in the
occurrence of paper jams, and premature wear and tear on the machine.

It may also occur that the paper meets all the specifications in this user guide, but the printing effect
remains unsatisfactory. This may be the result of improper operation, temperature or humidity exceeding the
allowable range, or other uncertain factors beyond our control. If you do not get the best results, use the paper
and printing media supported by this product. For the best printing quality possible, use only high-quality
copy paper.

Be sure to use print media conforming to the use of this machine.

Note:
 Contact a service representative before purchasing a large amount of paper.
 The use of paper that does not meet the specifications may result in machine failures that are

not covered by the warranty or service agreement of Gustec.

 When selecting materials to print, please note the following:
 Size: Use any size of paper that can easily fit into the tray paper adjustment guide.
 Weight: For multi-page feed printing: 70 to 90 g/㎡

For single-sheet feed printing: 70 to 200g/㎡.
 Brightness: Some papers are whiter than others, resulting in clearer, brighter images.
 Surface smoothness: The smoothness of the paper will have an influence on the clarity of the printed

content.
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 When selecting or packing paper, envelopes, or other special media, keep the following principles in
mind:

Be sure to use paper and other media that meet the specifications listed in "Paper Specifications" in Chapter
3.2.
 Trying to print on damp, curly, wrinkled, or torn paper can result in paper jams and suboptimal printing

quality.
 For the best printing quality, use high-quality copy paper.
 Avoid using paper with bump text, punched holes, and too smooth or rough textures. Otherwise, paper

jams may occur.
 Keep the paper in its original packaging until you use it. Place the box on a pallet or shelf, not on the

ground. Do not place heavy objects on the paper, whether it has packaging or not. Keep the paper away
from moisture or other environments that may cause wrinkles or curls of the paper.

 Store unused media in an environment with a temperature between 15 °C and 30 °C (59 ° F to 86 ° F).
Relative humidity should be between 10% and 70%.

 Moisture-proof packaging (such as plastic bins or bags) should be used during storage to avoid dirt and
moisture contamination of the paper.

 Fill a manual tray with a special type of paper one at a time to avoid jams.
 Use only media specifically recommended for laser printers.
To prevent special media (such as slides and label paper) from sticking together, they should be removed
immediately after printing.
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3.2.Paper specifications

This machine supports a wide range of media sizes. Capacity varies depending on media weight, thickness,
and environmental conditions.

Paper Dimensions Weight Capacity

A4 210*297mm

For multi-page feed: 70 to 90g/㎡
For paper cassettes: 250 sheets 70g/

㎡

Executive 184*267mm

A5 148*210mm

JIS B5 182*257mm
Envelope # 10 105×241mm

Envelope B5 182×257mm

Envelope C5 162×229mm

Envelope
Monarch

98×191mm

Minimum size 76*127mm
Maximum size 210*297mm

For single page feed: 70 to 200g/
㎡

For paper cassettes: 1 sheet of paper

Archival paper
Same as the minimum
and maximum sheet
sizes listed above

Kraft paper
Same as the minimum
and maximum sheet
sizes listed above

Label paper
Sulfuric acid

paper

Note:

 It is recommended to use standard paper and recycled paper for this printer. It is not recommended to
use a large amount of special paper, which may affect the printing life.

 Weight, composition, texture, humidity and other attributes are important factors affecting the
performance and output quality of the printer.

 When selecting a print medium, note the following:

1. Select the print medium according to the printing need.
2. The smoothness of the printing medium will affect the clarity of the printed content.
3. The use of printing media not meeting these specifications may cause damage to the printer.

 Paper jams may occur when print materials that are less than 5in (127mm) in length are used. For
optimal performance, make sure you store and manage your paper in the right way. See "Paper
Storage Environments" in Chapter 3.5.
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3.3.Paper usage principles

For best results, use ordinary 70 g/㎡ paper. Make sure the paper is of good quality, with no cuts, nicks,
breakage, stains, loose particles, dust, wrinkles, spots, curls, or hems. If you don't know what type of paper
you're loading, check the label on the package.

The following problems can lead to skewed printing quality, paper jams, and even damage to the machine:

Phenomenon Problem of the paper Solution
Poor printing quality
or inability of the

toner to adhere to the
paper, and problems
with paper feeding

Paper being too wet, rough, smooth, or
bumpy;

Try other types of paper with humidity
around 40-50%

Stripping, jamming,
curling

Improper paper storage
Place the paper flat inside its
moisture-proof package

Grayscale
background

deepening/printer
wear

Overweight paper Use lighter paper

Producing too much
crimp during feeding

Paper being too wet, wrong texture
orientation, or short texture structure

Use long textured paper

Paper jams, damages
to the machine

Paper cut or pierced; Cut or perforated paper should not be used

Paper feeding issues Rough paper edges Use good quality paper

Note:

 Do not use paper that needs to be printed with low-temperature inks, such as those
used for hot melt printing.

 The machine uses heat and pressure to hot melt the toner onto the paper. Ensure that
the ink for the paper can withstand this thermal setting temperature (0.1 seconds at
200 °C or 392 ° F)

3.4.Paper capacity

Paper position Capacity
Front facing downward feed

tray
250 sheets of 70g/㎡ paper
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3.5.Paper storage environment

The storage environment of the paper will directly affect paper feeding. Ideally, the environment of the
machine and the paper storage environment should be at or near room temperature, not too dry or too wet.
Paper absorbs moisture easily, and it absorbs and dissipates moisture quickly.

When assessing the paper storage environment, the following principles should be considered:

1. The air should not be too dry or too damp, and the paper should be stored at or near room temperature.

2. Dampness and heat can damage paper.

3. High temperature will cause moisture in the paper to evaporate, while low temperature will cause moisture

to condense on the paper.

4. Aheating system and air conditioner can remove most of the moisture from your room.

5. When you open the packaging of the paper and use the paper, the moisture in it will emit, resulting in

streaks and smudges.

6. A humid weather and water cooler can increase the moisture in your room. When the paper is unwrapped

and used, it will absorb too much moisture, which will lead to a light print color or a word-stripping
phenomenon. Moreover, the paper will be distorted and deformed by repeated moisture dissipation and
moisture absorption. This can lead to paper jams.

7. Please be careful not to buy too much paper, just buy enough paper for a relatively short period of time
(about 3 months).

8. Paper stored for a long time may encounter high temperature or high humidity, which will cause damage to
it. Planning is important to prevent damage to a large number of paper sources.

9. Unopened paper in a sealed package that stays stable for months before use. Papers that open packages can
be vulnerable to damage, especially if they're not wrapped with moisture-proof materials.

10. The paper storage environment should be properly maintained to ensure that the paper is in optimal

condition. Generally, ambient temperatures of 20 to 24 °C (68 to 72.5 ° F) and relative humidity of 45 to 55%
are required.

11. The best way to store unsealed paper is to repackage it with moisture-proof packaging. If the usage

environment of the machine is not ideal, you only need to open the required amount of packaging during daily
operation to avoid unnecessary changes in the humidity of the paper.
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3.6. Special paper

This product supports printing on special media. Special paper includes: archival paper, thick paper, label

paper, sulfuric acid paper, etc. When printing with special paper, be sure to set the type and size in the printer

driver for the best printing results.

Note:

 When using special paper or print media, make sure you select the matching print
type and size on the print settings for the best print.

 When printing with special media, we recommend feeding in only one sheet at a
time.

 Do not use carbon-free paper and tracing paper. Using these types of paper creates a
chemical odor and has the potential to damage the machine

 Remove the paper immediately after printing on special paper. Stacked paper can
cause jams or curls.

3.6.1. Thick paper

Different types of thick paper have different textures. For example, common kraft paper has the

advantages of hard texture, good toughness, wear resistance, and not easy to tear and break. However, the

color, smoothness, and flatness of kraft paper are much worse than those of offset paper, white plate paper,

and coated paper, so the following problems should be paid attention to during the printing process.

Type Specifications

Weight
The weight of heavy paper should not exceed 200g/㎡ , otherwise it may
cause paper jams.

Paper crimp The flatness is 0.02 in (within 5mm).

Dimensions Maximum size (210 * 279mm), minimum size (76 * 127mm)

Condition Paper should not be wrinkled, chipped, or otherwise damaged.

Documentation Do not use thick paper with a rough surface, shedding, or peeling powder.

Note:
Because thick paper is thick, in order to avoid serious paper jams, you should always load one
sheet at a time when printing on heavy paper.
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3.6.2. Label paper

To avoid damaging the machine, be sure to use the labels recommended for laser printers.

Type Specifications
Acidity A PH value of 5.5 or lower.

Dimensions Maximum size (210 * 279mm), minimum size (76 * 127mm).
Paper thickness 3.0~7mils（0.094~0.18mm）。

Paper crimp The flatness is 0.02 in (within 5mm).

High temperature resistance
When heated to 200 °C (392 ° F) in 0.1 sec, it cannot burn, melt, shift, or
release harmful substances.

Condition
Do not use labels that have wrinkles, bubbles, or other signs of backing
paper disengaging.

Humidity 40% ~ 60 %.

Note:

 Never repeat printing on the same label, or in parts of the label.

 If the label with the backing paper is not exposed between the labels, the blank
space between the labels will cause the label to disengage, causing serious paper
jams.

 Labels should be placed flat when used, only the whole sheet of labels should be
used.

 Make sure there is no bare sticky material between the labels.
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3.6.3. Sulfuric acid paper

Compared with other types of paper, sulfuric acid paper is drier and more prone to static electricity, and

it is easy to have empty, double and multiple sheets when moving paper. In order to ensure the smooth

running of paper, the temperature and humidity of sulfuric acid paper should be appropriate before printing. In

addition, due to the firmness of sulfuric acid paper, the separation of paper is more difficult than ordinary

paper with the same weight, so please put it in a well-ventilated place after printing.

Type Specifications

Weight
The weight of sulfuric acid paper should exceed 45g/㎡, otherwise it may cause paper
jams.

Paper crimp Flatness in 0.02 in (within 5mm);

Dimensions Maximum size (210 * 279mm) Minimum size (76 * 127mm)

High temperature
resistance

When heated to 200 °C (392 ° F) in 0.1 sec, it cannot burn, melt, shift, or release
harmful substances.

Condition Paper should not be wrinkled, chipped, or otherwise damaged;

Humidity
Print in an environment with a relative humidity of 45% to 55%, otherwise it will roll
on the toner cartridge due to static electricity. Sulfate paper is difficult to print in a
dry environment.

Note:
Due to the poor ink absorption performance of sulfuric acid paper, one sheet should always
be loaded at a time when printing on sulfuric acid paper, and each sheet needs to be dried
separately.
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3.6.4. Archival paper

The structure of different archival papers varies greatly, and the quality of paper varies greatly due to the

different production processes of manufacturers. When selecting file paper, you should follow the following

categories:

Type Specifications

weight
The weight of file paper should not exceed 200g/㎡ , otherwise it may
cause paper jams.

Paper crimp The flatness is 0.02 in (within 5mm).

Dimensions Max size (210 * 279mm) & min size (76 * 127mm).

Documentation File paper that can withstand machine pressure should be used

Condition Archival paper should not be wrinkled, chipped, or otherwise damaged;

High temperature resistance
When heated to 200 °C (392 ° F) in 0.1 sec, it cannot burn, melt, shift, or
release harmful substances.

Note:

 Do not use archival paper with pins, snaps, windows, or coated linings.

 Do not use self-adhesive adhesive or other synthetic materials for archival paper.

 Make sure the envelope is undamaged and not glued together before loading it into
the paper cassette.

 Do not use envelopes with open windows, coated liners, self-adhesive strips, or
other synthetic materials.
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4. Introduction to the Functions of the Control Panel

This chapter will introduce the operation of LED touch panel and the functions of all interfaces

This chapter contains:

 Main interface
-Energy Saving Mode
- Environmental Protection Model
-Alteration of the number of copies
-Start of copying
-Operation Tips
-Copy concentration, zoom value
-Type of photocopying
-System Parameter Settings

 System parameter setting interface
-Copy Scanning Dimensions
-Photocopying and scaling
-Photocopying Contrast
-Paper type
-Copy Background Adjustment
-Restore Default
-Local Information
-Wired Network Settings
-Altitude
-Energy Saving Sleeping
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Parameters of the colorful 4.3-inch LED HD capacitive touch screen display

Parameters Datum Description

Color 16.7 M (16777216) colour 24bit palette 8R8G8B

Display size (A.A.); 93.6 mm (W) × 56.16 mm (H) 480 × 800 pixel mode

Resolution 480 × 800 pixels 480 * 800 Graphic Dot Matrix

Backlight mode LED

Brightness
250nit (refers to the degree of lightness
and darkness of an object)

4.1.Main interface

Note:
It may vary slightly depending on the model you buy
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4.1.1. Energy Saving Mode

Energy saving mode button, the [Energy saving mode] is turned on by default.

 Enter the sleep mode:
After the energy-saving mode is turned on, if the printer has no operation tasks, it will enter the sleep mode
after 5 minutes.

 End sleep mode:

1. When the printer is in a sleeping state, click any area of the screen to end the current energy-saving mode,

return to the interface before hibernation, and the printer resumes operation.

2. When the printer is in a sleeping state, the sending host print task and host scan task can end the current

energy-saving mode, and the printer resumes operation.

3. When the printer is in a sleeping state, opening the front cover of the printer can end the current

energy-saving mode, and the printer resumes operation after closing the cover.
 Switch off the energy saving mode:
When the energy-saving mode is on, click the energy-saving mode button again to switch off the
energy-saving mode, and the printer will not enter the sleep state if the energy-saving mode is turned off.

4.1.2. Environmental protection model

The environmental protection mode button, the [environmental protection mode] is on by default.

 Turn off the environmental protection mode:
After the environmental protection mode is turned on, click the environmental protection mode button again
to turn off the environmental protection mode.
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4.1.3. Modification of copy number

 The system defaults to 1 copy.
 Copies range: 1 ≤ Copies ≤ 99.
 Modify the current number of copies:

1. To increase the number of copies, click the plus button below the number of copies .

2. Reduce the number of copies and click the minus button below the number of copies .

3. Manually enter the number of copies: click the number after the number of copies,
enter the required value after the number keypad appears and press the [OK] button.

4.1.4. Copy start button

[Start] button, only valid for text copying, graphic photo copying, and ordinary copying operations.

4.1.5. Operation tips

Prompt according to the current operation status.

4.1.6. Display of copy concentration value and copy zoom value

Displays the concentration and zoom values of the current copy operation.

4.1.7. Copying types

Text copying, graphic photo copying, ordinary copying, ID card copying, double-sided copying, bill copying,
all-in-one copying, ADF copying.

4.1.8. System parameter setting

System parameter setting button, click the [System Settings] button to enter the interface of system
parameter setting.
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4.2. Interface of system parameter setting

4.2.1. Size of copying and scanning

Operation steps: In the interface of system parameter setting, click the [Scanning Size] button to
enter the dialog box for copying size setting.

 Paper size type: A4 (default), A5, B5, envelope:

 Scope of paper size: text copying, graphic photo copying, ordinary copying, all-in-one copying.
 OK button: Save the modified paper size;
 Cancel button: Do not save the modified paper size.

Paper Specifications Paper size
A5 148×210mm

B5 176×250mm

Envelope 175×125mm
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4.2.2. Copy scaling

Operation steps: In the interface of system parameter setting , click the [Zoom] button to enter the

dialog box for copying zoom setting.

 Zoom type: Custom, Auto, 70%A4-A5, 94%A4-LT, 100%A4 (default).
 Scope of application for copying and zooming: text copying, graphic photo copying, and ordinary

copying.
 OK button: Save the modified copy zoom value;
 Cancel button: Do not save the modified copy zoom value.

Note:

If you select a zoom type of [Custom], you need to press [OK] to save after entering

a value using the numeric keypad in the Custom Input text box.
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4.2.3. Copy contrast

Operation steps: In the interface of system parameter setting, click the [Contrast] button to enter the

dialog box for copying contrast setting.

 Contrast type: Original (default), Weakened One, Weakened Two, Enhanced One, Enhanced Two.
 Scope of application of copying contrast: text copying, graphic photo copying, ordinary copying,

all-in-one copying, bill copying.
 OK button: Save the modified copy contrast value;
 Cancel button: Do not save the modified copy contrast value.
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4.2.4. Paper type

In the interface of system parameter setting, click the [Paper Type] button to enter the dialog box for

paper type setting.

 Interface for paper type setting

 Paper type: Normal paper (default), envelope paper, label paper, sulfuric acid paper, thick paper, tissue
paper, recycled paper, transparent film paper.

 OK button: Save the modified paper type;
 Cancel button: Do not save the modified paper type.
 Interface for copy paper type setting

 Paper type: Normal paper (default), envelope paper, label paper, sulfuric acid paper, thick paper, tissue
paper, recycled paper, transparent film paper.

 OK button: Save the modified paper type;
 Cancel button: Do not save the modified paper type.
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4.2.5. Copy background adjustment

Operation steps: In the interface of system parameter setting, click the [Background Adjustment] button

to enter the dialog box for copying background adjustment setting.

 Background adjustment types: Shallow,Original (default), Relatively Deep, Deep.
 Scope of application of copying contrast: text copying, graphic photo copying, ordinary copying,

all-in-one copying, bill copying.
 OK button: Save the modified copy background adjustment;
 Cancel button: Do not save the modified copy background adjustment.

4.2.6. Restore factory settings

Operation steps: In the interface of system parameter setting, click the [Restore Default] button to
enter the dialog box to Restore Factory Settings.

 OK button: All parameters of the printer are restored to factory settings;
 Cancel button: Do not perform a restoration to factory settings.
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4.2.7. Local information

Operation steps: In the interface of system parameter setting, click the [Local Information] button to

enter the dialog box for printer information setting.

 Print the manual (click the button to print a simple manual)

 Print machine parameters (click the button to print local configuration information)

 View information (click the button to view printer information)

 Firmware Upgrade (Upgrade the printer's current firmware program)

1. Connect the printer to a computer with a USB data cable;

2. Click the [Firmware Upgrade] button in the local information interface to enter the dialog box for

firmware upgrade;
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3. The computer host sends the upgrade data packet to the printer, and restarts the printer after the firmware
upgrade is successful.

4. Cancel button: After entering the dialog box for firmware upgrade, the host did not send an upgrade packet,
and the cancel button can be used; After entering the firmware upgrade dialog box, the host sends the upgrade
packet, and the cancel button cannot be used.

4.2.8. Wired Network Settings

Note: According to the model you purchased to confirm whether there is a network function!

Operation steps: In the interface of system parameter setting, click the [Network] button to enter the

network setting dialog box.

 Automatically get IP address (default):
Click the [Automatically Get IP Address] button, click the [OK] button, and restart the printer to activate
this function.
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 Get the IP address manually:

1. Click the [Get the IPAddress manually] button, and the dialog box of IP address input will pop up.

2. Click the IP address input field, the numeric keypad will appear, enter a valid IP address and press the [OK]
button to save the currently entered IP address.

3. Click the [OK] button to save the entered IP address.

 OK button: Save the currently input IP address;
 Cancel button: Do not save the currently input IP address.
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4.2.9. Altitude

Operation steps: In the interface of system parameter setting, click the [Altitude] button to enter the

dialog box for altitude setting.

 Altitude type: below 2000 meters (default), above 2000 meters.
 OK button: Save the modified altitude value;
 Cancel button: Do not save the modified altitude value.

4.2.10. Energy saving sleeping

Operation steps: In the interface of system parameter setting, click the [Energy Saving Sleeping] button

to enter the dialog box for Energy Saving Sleeping Setting.

Click the [On/Off] button and the [+/-] button to set the sleeping time.
 OK button: Printer enters the energy saving sleeping mode.
 Cancel button: Printer does not enter the energy saving sleeping mode.
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5. Install Driver Software for the Printer

This chapter describes step-by-step how to install driver software for the printer.

This chapter contains:

 System requirements
 Install driver software for the printer with the Installation Tool
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5.1. System requirements

Before you install, make sure yourWindows system meets the minimum

requirements.

Operating system CPU RAM Hard disk space

Windows 2000
Pentium II 400 MHz
(Pentium III 933 MHz)

64 MB（128 MB） 600 MB

Windows XP
Pentium III 933 MHz
(Pentium IV 1 GHz)

128 MB（256 MB） 1.5 GB

Windows 2003
Server

Pentium III 933 MHz
(Pentium IV 1 GHz)

128 MB(512MB) 1.25 GB to 2GB

Windows 2008
Server

Pentium IV 1 GHz
(Pentium IV 2 GHz)

512 MB(2048 MB) 10 GB

Windows Vista Pentium IV 3 GHz 512 MB(1024 MB) 15 GB

Windows 7

Pentium IV 1 GHz 32-bit or 64-bit
processor or higher

Supports DirectX 9 graphics with
128 MB (to enable Aero themes)

1 GB（2 GB）
16 GB

Windows Server
2008 R2

Pentium IV 1 GHz (x86) or 1.4 GHz
(x64) processor (2 GHz or faster)

512 MB(2048 MB)
10 GB

Windows 8

Pentium IV 1 GHz 32-bit or 64-bit
processor or higher

MicrosoftDirectX 9 Graphics Device
withWDDM Driver

2 GB (or more memory) 20 GB

Windows 8.1

Pentium IV 1 GHz 32-bit or 64-bit
processor or higher

MicrosoftDirectX 9 Graphics Device
withWDDM Driver

2 GB (or more memory) 20 GB

Windows 10

Pentium IV 1 GHz 32-bit or 64-bit
processor or higher

MicrosoftDirectX 9 Graphics Device
withWDDM Driver

2 GB (or more memory) 20 GB

Note:
 For allWindows operating systems, the minimum requirement is Internet Explorer 5.0

or a later version of the browser.
 You must have administrator privileges to install software.
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5.2. Installing Printer Driver and Scanning Software with the Installation Tool

If you want to use this device as a printer and scanner in your computer equipment, you must install a

print/scan driver.

You can install some or all of the following components:

 Printer driver: Use this driver to make full use of the various functions of this printer.

 Scanner driver: Provides the TWAIN andWIA drivers required to scan documents locally.

 Scanning software: Windows-based scanning software that comes with your machine and enables you

to Complete the scan with ease. And the image can be sent out by e-mail.

It is recommended that you install all of the above components.

 Installation steps:

1. Make sure the printer is connected to your computer via a USB cable and is powered on.

2. Insert the randomly provided optical disc into the optical disc drive, the optical disc should run
automatically and the installation window will appear.

Note:

 If the "New Hardware Wizard" window appears during installation, click the × button

in the upper right corner of the window to close the window, or click the Cancel button

to exit the window.

 If you are a user of theWindows operating system, install the software using the

included CD .
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3. Click [Run SetupMain.exe], and the driver installation and loading interface will pop up.

4. Click [Next], the installation tool will automatically detect the connected printer, and jump to the following
interface

1）Driver Name:

The printer driver name that needs to be installed, this example automatically detects that the printer driver

name is: GUSTEC GT231ADW.

If the printer is not connected to the computer, you need to manually select the printer family and model,
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2) Printer connection method: Select the printer driver installation method.

No connection: The printer driver is pre-installed in the computer system, and it is automatically installed

after the printer is connected to the computer.

USB connection: The printer is connected to the computer through a USB data cable.

Network connection: The printer is connected through the network (network model optional).

3) Installation path: Select the installation path, which can be modified. It is recommended to use the default

option (default C:

5. Click [Next], the installation tool will automatically install the printer driver and software.

6. When installing drivers and software, the installation time may be slightly different due to the computer

environment used, please wait patiently.
When the installation prompt information shows that the scanning driver, printing driver, and scanning
software have been successfully installed, congratulations on using the scanning function and printing
function. Note: After the installation is successful, please restart the computer.
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7. After restarting the computer, please print the [Printer Test Page] to test whether the machine is available.
Refer to 7.4. Printer Properties dialog box for details.

Note:

If a Windows security prompt pops up during installation, click Always Install This Driver
Software (I) to continue installation.

Note:

 If your computer does not have a CD-ROM drive, please go to the official website to

download the driver that matches your device.

 Open the folder after the download is completed (laser all-in-one machine installation disc),

 Considering the account permission factor, right-click the [SetupMain.exe] application, in

the pop-up options menu,

 Select [Run as Administrator (A)] to install the printer software.
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6. Setting up and Querying Printer Information

This chapter contains:

 Use the Gustec Setup Tool
-Basic information
-Wired Network Settings
-Wireless Network Settings
-Other settings
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6.1.Use the Gustec Setup Tool

 Preparation before setting up and querying:

1. Verify that both the printer and computer are turned on and connected correctly.

2. After installing the Gustec Setting Tool, you will see the [Gustec Printer Setting Tool] icon on the desktop.
Double-click the icon.

1. Basic information 2. Wired network settings 3. Wireless network settings 4. Firmware update 5.
Other settings
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6.1.1. Basic information

 Basic information provides various information about the printer.

Basic information (product information, print information, printer status information, consumable information).

1. Product information:

Used to display the printer's name, firmware version, serial number;

2. Print information:

Used to display the total number of pages printed by the printer and the number of pages printed on special paper;

3. Printer status information:

Used to display various states and error codes of the printer;

4. Consumable information:

Type of toner cartridge

Toner cartridge capacity

Actual number of pages printed

Theoretical number of pages printed

Average coverage

Remaining amount of toner cartridge.
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6.1.2. Wired network settings

Note:
 Make sure your printer supports wired networking;

 Please confirm that your printer and computer are connected to the same local area network;

 Connect the printer to the computer through the USB data cable;

 After the wired network setting is completed, it can be printed through the computer under the same local

area network.

1. Please find [Gustec Printer Setup Tool] on the desktop.

2. After double-clicking to open the software, please click to enter the [Wired Network Settings] tab,

Select [Get IP Automatically] and click the [Settings] button, wait for a few seconds to perform the query

operation, as shown in the figure below.
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3. After successful setting, please click [Query].

After the query is complete, you can do wired network printing by adding a network port.

For specific methods, please refer to 7.4. 1 PrinterAdd IP Port.
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6.1.3. Wireless network settings

Note:
 Please confirm that your printer and computer support wireless network function;

 Please confirm that your printer and computer are connected to the same local area network;

 Connect the printer to the computer through the USB data cable;

 After the wireless network setting is completed, it can be printed through the computer under the same

local area network.

1. Please find [Gustec Printer Setup Tool] on the desktop.

2. After double-clicking to open the software, please click to enter the [Wireless Network Settings] tab,

Click [Search] to find available wireless network devices, as shown in the figure below.
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3. Click the name of the network you want to connect to and enter the password.

4. Select [Automatically obtain IP], and click [Settings], wait for a few seconds to perform the query operation,

as shown in the figure below
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5.After successful setting, please click [Query].
You can use WIFI printing by adding a network port once the query is complete.
For specific methods, please refer to 7.4. 1 PrinterAdd IP Port.
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6.1.4. Other settings

Other settings: Used to set and query the printer's energy saving information.

 Query: Query for the sleep state and sleep time of the printer.
 Settings: Set printer hibernation on and off and hibernation time
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7. Print function

This chapter describes printing options and common printing tasks in the Windows environment. The exact
steps you take to print a document may vary depending on the application you use. The printer models described
in the following example are for reference only and do not represent the actual installed printer model.

This chapter contains:

 Print Document
 Print to File (PRN)
 Printer Settings

-Layout tab
-About tab
-Quick Settings Tabs
-Advanced Settings

 Printer Properties Dialog Box
-Printer Add IP Port

 Print multiple pages on one page (N-up print/all-in-one print)
 View Print Queue
 Cancel printing task
 Drive single/double-sided switching
 File slip/double-sided switching

Note:

 The Printer Driver Properties window displayed in this User Guide may vary depending
on the printer you are using.

 Please check that the "operating system" is compatible with your printer. See Chapter
5.1, System Requirements.

 If you need to know the exact name of the printer, you can check the disc that is
provided at random.
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7.1.Print documents

Here are the basic steps required to print in a generic application.

1. Open the document that needs to be printed.

2. Select the Print option from the File menu. A print window is displayed, which may vary slightly from

application to application.

3. Select the basic print settings in this print window, which include the number of copies and the print range.

4. Select your printer driver from the drop-down list (here select GUSTEC GT231ADW ).

5. In order to take full advantage of the various printer functions provided by the printer driver, in the print

window of the application,
Click the Properties or Preferences button. Then set the functional properties you need on the next screen,
Click the OK button to save and close the Printer Properties window.

6. To start a printing task, click the OK or Print button in the print window.

Note:

If the Print window displays the Settings, Printer, or Options buttons, click these item
buttons instead to go to the Printer Properties window to set up the printer.
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7.2.Print to File (PRN)

Sometimes you need to save your print data as a file for your use, follow these steps:

1. Open the file that needs to be printed.

2. Select the Print option from the File menu. A print window is displayed, which may vary slightly from

application to application.

3. You need to select the [Print to File] option box in the print window.

4. To start a printing task, click the OK or Print button in the print window.

5. Select the folder path and specify the file name.

6. Then click the OK button to save.
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7.3.Printer settings

You can use the Printer Properties window to access all the printer options you need to use the printer. You
can view and change the settings required for a printing task by displaying printer properties. The Printer
Properties window varies depending on the operating system. This article shows the Properties window on
Windows 10, and the Printer Driver Properties window in use may vary depending on the printer you are using.

In aWindows system, the steps to open the dialog box of [Printer Preferences] are:

1. Click the Windows taskbar [Start] menu button

2. Select [Control Panel] Commands → [Hardware and Sound] Options → [Devices and Printers] Options.

3. In the Device and Printer dialog box, select your printer driver icon (here select GUSTEC GT231ADW)

4. Right-click the printer driver icon here, pop-up menu and select [Printer Preferences]

5. Select the tab you want to change the settings, change its property settings, and then click the [OK] button

Note:

 Most Windows applications override the settings you specify in the printer driver. First
change all the print settings available in the software application, and then use the printer
driver to change the rest.

 The settings you changed are only valid if you are using the current program. To make
your changes permanent, go to the Devices and Printers page to make changes.

 The following steps apply to Windows. For information about other Windows operating
systems, see the appropriate Windows User Guide or Online Help.
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7.3.1. Layout tab

 The Layout tab provides options for adjusting how the document is displayed on the printed page.
Layout tabs (Paper Orientation, Duplex Printing, Page Order, Page Formatting).

 Paper orientation (O): Paper orientation can be used to select the direction in which information is printed
onto the page.

 Portrait is printed in the width direction of the page, that is, the stationery style.
 Landscape is printed along the length of the page, that is, form style.

Landscape Portrait
 Duplex printing: Used to set the print format of the paper.
Note: Confirm whether there is double-sided printing function according to the model you purchased!
 Flip Direction (O):

Short side flip long side flip
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 Page Order (R): Used to set the printing order of the page, select the printing order from the drop-down box.
 From front to back: The printer prints all pages from the first page to the last page (if the number of pages is:

1, 2, 3).
 From back to front: The printer prints all pages from the last page to the first page (if the number of pages is:

3, 2, 1).
 Page Format (N-up print)
Number of pages printed per sheet: drop-down list, select the number of pages you want to print on each sheet (1,
2, 4, 6, 9, or 16).
Draw Borders (W): Select Print Page Borders to print borders around each page on the paper if desired.

7.3.2. About tab

TheAbout tab is used to display copyright notices and driver version numbers.

Note:

The Draw Border option is only valid if the number of pages per sheet is greater than 2.
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7.3.3. Quick settings tab (Paper Type, Print Resolution)

 Paper type: Please choose the type of paper that matches the printing paper contained in the paper cassette
to obtain the best printout effect,

Otherwise, the printing quality may not meet your requirements.

 Print Quality (Resolution)
 600 dots per inch
 1200 dots per inch

Depending on the printer model, the [Resolution] option that can be selected may also vary.
The higher the setting, the sharper the characters and images printed, and a higher setting also increases the time it
takes to print the document.
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7.3.4. Advanced settings (Paper Size, Copies)

In theWindows system, the steps to open the printer advanced settings dialog box:

1. Click theWindows taskbar [Start] menu button.

2. Select [Control Panel] Commands → [Hardware and Sound] Options → [Devices and Printers] Options.

3. In the Device and Printer dialog box, select your printer driver icon (here select GUSTEC GT231ADW).

4. Right-click the printer driver icon here, pop-up menu and select [Printer Preferences].

5. In the Printer Preferences dialog box, click the [Advanced] menu button to open the Advanced Options dialog
box.

6. Select the option you want to change the settings, and then click the [OK] button.

 Paper Specification: Used to set the size of the paper to be loaded in the tray.
 Copies: The number of copies used to set printing tasks.
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7.4.Printer properties dialog box

The Printer Properties dialog box allows you to set the printer configuration.
The following steps are for Windows 10. For information about other Windows operating systems, refer to the
appropriate Windows User Guide or Online Help.

1. Click the Windows taskbar [Start] menu button.

2. Select [Control Panel] Commands → [Hardware and Sound] Options → [Devices and Printers] Options.

3. In the Device and Printer dialog box, select your printer driver icon (here select GUSTEC GT231ADW).

4. Right-click the printer driver icon here, pop-up menu and select [Printer Properties].

5. Click the Printer tab and set the options.

 General tab: Print test page, printer model display, printer feature introduction
 Sharing tab: After setting up your printer sharing, other computers can access your printer through the LAN
 Ports: Add ports, remove ports, configure ports
 Security: Set permissions on your printer
 About: Show copyright notice and driver version number
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7.4.1. Add an IP Port for the printer

Note: Please confirm that your printer supports network functions!

1. Open the [Printer Properties] dialog box and click the [Port] button, as shown in the legend below.

2.A. Click the [Add Port] button.
B. Select [Standard TCP/IP Port] and click the [New Port (P)] button.
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3. Click the [Next Page] button on the add port interface, as shown in the red box below.

4. Enter the corresponding IP address in the IP address bar, and then click the [Next Page] button, as shown in the

red box below.

Note: 1. If you are a wired network model, check and set the network IP address of the printer:

For specific methods, please refer to 6.1. 2. Wired Network Settings.

2. If you are a wireless network model, check and set the network IP address of the printer:

For specific methods, please refer to 6.1. 3. Wireless Network Settings.
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5. Click the [Next] button until the printer port is added.

6. Please print [Printer Test Page] to test whether the newly added port is available.
Refer to 7.4. Printer Properties dialog box for details.

7.5.Print multiple pages on one page (N-up print)

N-up printing is referred to as all-in-one printing, that is, printing multiple pages on one sheet of paper. You can
choose how many pages you want to print on a sheet, and if you want to print multiple pages on each sheet, the
pages will be scaled down and arranged in the specified order, up to 16 pages on a sheet.

1. To change print settings from a software application, visit Printer Properties. See Chapter 7.1, "Printing

Documents."

2. Select Page Formatting on the Layout tab.

3. In [Number of pages printed per sheet], select the number of pages to print on each sheet (1, 2, 4, 6, 9, or

16).

4. If you want to print a border around each page on the paper, you can select the Draw Border check box.

The Draw Border check box is only valid if the number of pages printed per sheet is greater than or equal
to 2 pages.

5. Click the [OK] button to print the document.
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7.6.View printing queue (tasks currently printing)

1. Click Windows' Start button.

2. Select [Control Panel] Commands → [Hardware and Sound] Options → [Devices and Printers]

Options.
3. In the Device and Printer dialog box, select your printer driver icon (here select GUSTEC GT231ADW).

4. Click [View what is printing now] to view the tasks that are currently printing

7.7.Cancel printing tasks

If a printing task is waiting in the print queue or printer offline program, delete the tasks in the following way:

1. Click the [Start] button on the Windows taskbar.

2. Select [Control Panel] Commands → [Hardware and Sound] Options → [Devices and Printers]

Options.

3. In the Device and Printer dialog box, select your printer driver icon (here select GUSTEC GT231ADW).

4. Click [View what is being printed now], and from the [Document] menu, select the [Cancel] option.

Note:

You can simply open this window by double-clicking the printer icon in the lower right
corner of the Windows desktop.

Note:

You can also cancel a printing task with the following methods

 In the Devices and Printers dialog box, double-click your printer with the mouse to see
what is being printed.

 Click the document that you want to cancel, and from the Document menu, select
Cancel.

 Right-click the document that you want to cancel, and from the shortcut menu, select
Cancel.

 You can cancel the current task by clicking the Cancel button on the printer control
panel.
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7.8.Drive single/double-sided switching

1. Click the Windows taskbar [Start] menu button.

2. Select [Control Panel] Commands → [Hardware and Sound] Options → [Devices and Printers]

Options.

3. In the Device and Printer dialog box, select your printer driver icon (here select GUSTEC GT231ADW).

4. Right-click the printer driver icon here, pop-up menu and select [Print Preferences].

5. Click Print Preferences and select Duplex Print in Layout

 Flip Direction (O):

Short side flip long side flip

6. Then click the OK button to save.
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7.9.File slip/double-sided switching

1. Open the file that needs to be printed.

2. Select the Print option from the File menu. A print window is displayed, which may vary slightly from

application to application.

3. You need to select the copy frame of [Duplex Print] in the print window.

4. To start a printing task, click the OK or Print button in the print window.
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8. Scanning Function

Using this product, the original can be scanned and stored in different formats to the computer,
supporting applications that comply with TWAIN and WIA standards. The printer models described in the
following example are for reference only and do not represent the actual installed printer model.

This chapter contains:

 Scanning with Scanning Software
-Scan to document
-Scan to mail
-Scan Settings

 Scan with WIADriver
-Windows Driver Scan

Note:

 To scan with this machine, the appropriate software must be installed. For more
information, see the instructions "5. Install Printer Driver Software" to install the
scanning software.

 You can confirm the model number of your printer by running the program on the
accompanying disc.

 The maximum resolution attainable depends on a number of factors, including computer
speed, available disk space, memory, image size scanned, and more. Therefore,
depending on the system and what you scan, you may not be able to scan at a specific
resolution, especially when using enhanced DPI.
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8.1. Scanning with the Scanning Software

Gustec Scanning Software is a software that comes with random, scanning software enables you to complete
scanning with ease.
How to install scanning software, see "5. Installing Printer Driver Software"

 PREPARATION BEFORE SCAN:

1. Verify that both the printer and computer are turned on and connected correctly.

2. Put the scanned manuscript on the glass panel of the scanner table.
 How to place the original, see "9.3. Placing Flat Scanned Documents"

3. After installing the scanning software, you will see the scan icon on the desktop. Double-click the scan

icon.

1．Toolbar 2. Menu bar 3. Window toggle close area 4. Scan setting area 5. Image display area 6.
Status bar

Note: How to use the help function of Gustec scanning software

For more information about the Gustec scanning software, please select the [Help] button on
the menu bar, from which you can view the help information provided by the scanning
software.
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Note: If the storage format you choose is PDF, you can check "multi-page scan save as one PDF". That is,
multiple single PDF files can be scanned into a PDF file.

8.1.1. Scan to File

 Follow these steps to scan the original to a file:

1. Open the scanning software.

2. Click the [Output Settings] button in the toolbar, and set the storage method of the scanned picture in the
pop-up dialog box.
Select File in Image Processing, enter a valid local folder location in Folder Path, and click Save.

3. In the basic settings of the scanning setting area, select the storage format, scanning mode, scanning color
mode, scanning resolution and scanning area range of the scanning file.

4. Click the [Scan] button in the toolbar, and the scanning software will scan according to the current scanning
setting parameters, prompting the scanning progress. After the scanning is completed, the scanned image will
be displayed in the [Image Display Area], and in the [Status Bar] Display basic image information.

5. After the scan is completed, if [Output Settings] chooses to store to a local folder, the picture file named
after the current system time will be stored in the set folder path.

6. Click the [Open Directory] button in the toolbar, the scanning software will automatically open the local

folder where the files are stored, and you can find the picture files stored in this scan.
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8.1.2. Scan to Mail

 Follow these steps to scan to mail using software:

1. Open the scanning software.

2. Select [Output Settings] in the software, and set the storage method of the scanned picture in the pop-up
dialog box.

3. Select [Email] in [Image Processing Method], enter a valid email address path in [Email Address], and

then press the [Save] button.

4. In the basic settings of the scanning setting area, select the storage format, scanning mode, scanning color
mode, scanning resolution and scanning area range of the scanning file.

5. Select the [Scan] button in the main interface of the software.

6.After the scan is completed, an email will open on the screen, and the scanned document will appear in the
email as an attachment.

Note:

 Before using the scanning software to scan to e-mail, install the OutLook client and set
up the mailbox.

 Due to the size requirements of attachments to e-mail messages, e-mail messages will
not be successfully scanned when the file size you scan exceeds the allowed size of mail
attachments. (Files that exceed the message attachment size requirement are stored in the
folder path set in Output Settings)
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8.1.3. Scanning settings

Please change the scanning parameters on the left side of the Gustec scanning software according to your
needs.
 Storage format of scanned files

Choose the storage format of the scanned image according to your needs. The storage formats available are:
BMP, JPEG, TIFF, and PDF.

 Scanner resolution and color

If the image you scan out doesn't look as good as you expect, it may be that you have selected a resolution or
color setting in your scanning software that doesn't match your needs. Resolution and color affect the
following characteristics of the scanned image:

Image sharpness, level change (smooth or rough), scan time, scan size

Resolutions supported in scanning software: 75dpi, 100dpi, 150dpi, 300dpi, 600dpi, 1200dpi

Colors supported in scanning software: true color, grayscale, black and white

 Scanning area

When you scan with different sizes of originals, in order to make the image output of the scan achieve the
desired effect. You can set [Scan Area] in the scanning software. The scanning areas that the software can
choose from are:

Full Draft Desk, A4, A5, B5, Letter, Custom

Note:

 Setting Scanning Zones After selecting [Custom], you can define the area to scan by
yourself. The size range that can be defined is a minimum of 1 inch by 1 inch and a
maximum of 8.5 inches by 11.7 inches.

 The size of the full draft table is: 8.5 inches × 11.7 inches

Note: Setting the resolution and color to higher values creates larger files, which can take up
a lot of disk space and slow down the scan speed. Before you set the resolution and color,
determine the purpose of the scanned image.
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 Advanced settings

Image adjustment can also be performed when scanning with scanning software; The supported image
resizing content is as follows:

 Brightness: How bright and dark an image is

 Contrast: The degree of difference between light and dark in an image

 GAMM: Nonlinear Tone Adjustment for Images

 Threshold: Distribution of black and white dots in an image

 Color Correction: Adjust the saturation of an image

 Hue: Adjust exposure

 De-reticulation: Removes gridlines from a picture to make the image smoother

 Rotation: Rotate the image as you want (0 °, 90 °, 180 °, 270 °)

Note: The threshold can only be set when the color mode is black and white mode.
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8.2. Scan with the WIADriver

It also supports scanning images with theWindows Image Acquisition (WIA) driver.WIA drivers work
with digital cameras and scanners. Unlike the TWAIN driver, the WIA driver can be used to scan and easily
process images without the use of other software. The printer models described in the following example are
for reference only and do not represent the actual installed printer model.

8.2.1. Windows driver scanning

1. Place the single-page document face down on the document scanning glass panel.

2. Right-click the [Start] menu on the desktop, and in the pop-up options, select [Control Panel] Command
→ [Hardware and Sound] Options → [Devices and Printers] Options.

3. Right-click the [GUSTEC GT231ADW] device driver icon in the [Devices and Printers] dialog box,

select the [Start Scan] command, and the New Scan Application dialog box will appear.

4. Select the scan preferences and click the [Preview] button to see how the preferences affect the picture.

5. Click the [Scan] button.

Note:WIA drivers can only be used on Windows systems with USB ports.
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9. Copying Operation

This chapter describes the operation of each copy mode.

This chapter contains:

 Learn how to select print media for copying
 Prepare the original document
 Place Flat Scan Document
 Set Copy Parameters
 Ordinary copying

-Copying of texts
-Photocopying of pictures and texts

 Copy of ID card
 Double-sided copying
 Copy of bill
 All-in-one copying
 ADF copying
 Lack of paper for copying
 Copy cardboard
 Cancel copy operation
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9.1.Learn how to select print media for copying

To learn how to select a print medium, see "Paper Specifications" in Chapter 3.2.

9.2.Prepare the original document

Please note the following when selecting an original manuscript:

 Do not load documents larger than 300 x 220 mm.

 Remove the staples and paper clips before loading the document to prevent damage to the document scanning glass

plate.

 Make sure the glue, ink, or modification liquid on the paper is completely dry before loading the document.

 Do not load books, pamphlets, slides, or documents with other unusual features.

9.3.Place flat document for scanning

1. Open the document cover.

2. Place the document face down on the document scanning glass panel.
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3.Align the manuscript with the positioning indication in the upper left corner of the glass plate. If the manuscript does
not match any provided size marks, please align the upper left corner of the manuscript with the arrow.

4. Close the document cover.

Note:

 Make sure the ink or correction fluid on the manuscript is completely dry before
placing it on the glass manuscript.

 Textured rough, bumps, grease stains, very smooth paper or manuscripts will lead to
poor printing results.

 Please make sure that there is no dirt, fluff and other dirt on the original manuscript.

 Dust and fluff on the document scanning glass plate may cause black spots on the
printed paper, please keep it clean.

 Be careful not to hurt yourself when closing the document cover.

 If the cover plate is opened during copying, it may affect the quality of copying and
increase the amount of toner.

 If you need to copy a page from a book or magazine, you should open the cover and
start copying again.
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9.4. Set copying parameters

Set the following reasonable copying parameters for the current copying job, as needed, for better copying results before
performing the copying operation.

You can change the corresponding settings through the System Parameter Settings menu.

1. Press the [Settings] button on the control panel to enter the [System Parameter Settings] interface.

2. Select the required modification options and enter the corresponding dialog interface.

3. Select the options you need to set. Press OK to save the settings.

Note:

 Scan size, zoom, contrast, concentration, background adjustment, paper type, when the options are

set, the parameter settings will always take effect, and the settings will return to default after the

machine restarts.

 All-in-one, ID card setting, when the copying is over, the switch panel button or the machine
restarts, the parameter settings will be restored to the default
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9.5.Ordinary copying

9.5.1. Text copying

Text copy button, suitable for documents whose content is mainly text.

Operation steps:

1. Click the [Text Copy] button, click the [Start] button;

2. The copy prompt box appears to copy the text.

9.5.2. Graphic photocopying

Graphic photo copy button, suitable for text and picture mixed documents.

Operation steps:

1. Click the [Graphic Photo] button, click the [Start] button;

2. The copy prompt box appears, and the image-text mixed copy operation is performed.
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9.6.Copying an ID card

ID card copying button.
Click the [ID card copying] button on the main interface to enter the ID card copy dialog box.

 ID card copying mode: A4 up and down (default), A4 single-sided, A5 up and down, A5 around.

ID Card Copy Placement Area

 Up and downA4: It is the default mode, and the certificate is placed in the "orange area" on the left half of the glass

manuscript table.

 A4 Single side: Place the certificate on the left half of the glass manuscript table in the "orange area".

 Up and downA5, around A5: Place the certificate in the "blue area" of the glass manuscript table.



91Page

 Prompt area: Ready, copying the front, please turn to the back after copying, copying the back.
 Scan progress bar: Prompts based on the current scan progress.
 Start button: ID copy start button.
 Cancel button: If the ID card copy operation is not performed, press the [Cancel] button to exit the ID card copy

dialog box;
When the copying mode of the ID card is up and down A4, up and down A5, and around A5, after the
front copy is completed, press the [Cancel] button, and only the front will be copied.

9.7.Double-sided copying

Double-sided photocopy button.
On the main interface, click the [Double-Sided Copy] button to enter the Double-Sided Copy dialog box.

 Tip area: Ready, Scanning Side 1, Please change page after scanning Side 1, Scanning Side 2.
 Concentration: Shallow, Standard (default), Deep
 Start button: Duplex copy start button.
 Cancel button: If there is no double-sided copying operation, press the [Cancel] button to exit the double-sided

copying dialog box;
When the double-sided copying operation is performed, after the first side copying is completed, press the [Cancel]
button to cancel the double-sided copying operation.
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Operation steps:

1. Open the upper cover of the scanner and place the first side of the original on the scanner glass where the arrow
indicates,
Then, close the scanner cover.

2. Touch the [Duplex Copy] button, press the [/-] button on the operation panel, and set the number of copies to be copied;
In the concentration area, set the required copy concentration.

3. Press the [Start] key to start copying. The screen displays [Scanning side 1], indicating that scanning is in progress.
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4. After the scan is completed, the screen will display [Please change the page after the scan on the first side], turn over
the manuscript, and close the cover.

5. Press the [Start] button to scan the second side, the screen shows [Scanning the second side], after the scanning is

completed, start copying.
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9.8.Copying bills

For better copying, the Bill Copy dialog box provides options for setting contrast and shade parameters. You can adjust

the contrast and brightness according to your needs.

Ticket copy button.
Click the [Bill Copy] button on the main interface to enter the Bill Copy dialog box.

 Lightness: Shallowest, Shallow, Standard (default), Deeper, Deepest
 Contrast: Weaken 2, Weaken 1, Original (default), Enhanced 1, Enhanced 2
 Start button: Bill copy start button.
 Cancel button: Press the [Cancel] button to exit the ticket copy dialog box;
Operation steps:

1. Select the brightness value and contrast value.

2. Click the [Start] button to switch to the copy prompt box to copy the bill.

Note:

 Contrast and brightness remain in effect until the machine is restarted,

 After the machine is restarted, it reverts to default (brightness: standard contrast: original).
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9.9.All-in-one copying

All-in-one copy button.
Click the [All-in-One Copy] button on the main interface to enter the All-in-One Copy dialog box.

 All-in-one layout: landscape (default), portrait.
 All-in-one types: 2 pages (default), 4 pages, 9 pages.
 Tip area: Ready, copying first page, copying first page completed, copying second page...
 Scan progress bar: Prompts based on the current scan progress.
 Start button: All-in-one copy start button.
 Cancel button: If the all-in-one copy operation is not performed, press the [Cancel] button to exit the all-in-one copy

dialog box;
When the all-in-one copying mode is 2 pages, 4 pages, 9 pages, press the [Cancel] button after the

copying of the current page is completed,
End the copying operation early, switch to the copying prompt box for printing operation.

Note: The Arrangement parameter remains in effect until the machine is restarted. After machine reboot,
revert to default (landscape 2 in 1)
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9.10. ADF copying

You can use the autofeeder to copy multiple sheets automatically and continuously.

1. Put the original manuscript in the document feeder with the front up and the top first.

2. After loading the original, slide the paper guide plate on the document feeder to the appropriate position.
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3. The screen operation prompt box shows "ADF document has been loaded".

4. Press the [Start] button to start ADF copying.

9.11. Lack of paper for copying

Operation steps:

1. When the copying operation is short of paper, enter the short of paper interface.

2. Put in the paper, click the [Continue Printing] button on the paper shortage interface, and continue the copying

operation.

Note:
 Do not mix paper with different product numbers, sizes, thicknesses or surface treatments in the feed

tray of the automatic feeder.
 Remove all paper clips or staples from the paper. They can cause auto feeder failure.
 Do not force the paper into the automatic feeder.
 You should scan the paper with a flatbed scanner if

1. Creased, crumpled or torn.
2. Punch, curl or fold.
3. Stick to other paper with glue or other substance
4. Put together with tape or something.
5. Too small or too thin, such as invoices or securities.
6. Bound documents.

 The document feeder holds up to 50 sheets and feeds them sheet by sheet.
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9.12. Paper jam during copying

Operation steps:

1. When the copying operation is abnormal and the paper is jammed, enter the paper jam interface.

2. Open the front cover of the printer, clean the printer paper, and continue copying after closing the cover.
(See section 11.1, "Clear paper jam," for how to clear paper.)

9.13. Cancel copy operation

 Copy Operation → Cancel when scanning:

1. Text copying, graphic mixed copying, bill copying, ADF copying operations, the scanner clicks the copying

prompt box when scanning

The [Cancel] button of.

2. You can cancel the current copy operation task.

 Copy Operation → Cancel when printing:

1. When the number of copies is less than or equal to 3 copies, when the scanner completes scanning and starts

copying, press the [Cancel] button, and cancel the copying task after all the copying tasks are executed.

2. When the number of copies is greater than 3 copies, press the [Cancel] button on the current copy page, and cancel the

current copy task after continuing to copy 3 pages.

Note:

Printer jammed abnormal, the current page will not be reprinted after clearing the jammed
paper!
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10. Maintenance

This chapter describes information about machine and toner cartridge maintenance.

This chapter contains:

 Cleaning machines;
-Cleaning the exterior of machinery
-Cleaning the interior of machinery
-Cleaning scanning devices

 Maintaining Toner Cartridges
-Toner Cartridge Storage
-Shaking toner cartridge
-Replacement of toner cartridges
-Cleaning toner cartridges
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10.1. Cleaning the machine;

To maintain printing quality, follow these steps to clean the machine every time you change the toner cartridge or have
printing quality issues.

10.1.1. Cleaning the exterior of the machine

Clean the machine shell with a soft lint-free cloth. The soft cloth can be slightly dampened with water, but be careful not
to let the water drip onto or into the machine.

10.1.2. Clean the inside of the machine

Paper scraps, toner and dust particles can build up inside the machine during printing. This can cause printing quality
issues, such as toner spots or stains. Cleaning the inside of the machine can eliminate or reduce such problems.

1. Turn off the machine, unplug the power cord, and wait for the machine to cool down.

2. Remove the auto-feed tray.

Note:

Washing the machine shell with a cleaner that contains a lot of alcohol, solvents, or other
strong substances may cause the shell to fade or crack.

When cleaning the inside of the machine, be careful not to touch the ink transfer roller under
the toner cartridge. Grease on your fingers can affect printing quality.
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3. Open the front lid

.

4. Pull out the toner cartridge and lower it gently. Place it on a clean, flat surface.

5. Wipe away the dust and spilled toner around and inside the carton with a lint-free cloth.

Note:
Do not touch the black ink transfer roller inside the machine.
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6. Replace the toner cartridge and close the front cover.

7. Plug in the power cord and turn on the machine.

Note:
For ADF machines, paper scraps need to be cleaned regularly, please wipe with a soft rag.

10.1.3. Clean the scanning device

Keeping the scanner clean helps you get the best copy. It is recommended that you clean the scanning device once
every day at the beginning of work, and this work can also be considered necessary at other times.

1. Dip a lint-free soft cloth or paper towel slightly with water.

2. Open the document cover.

3. Wipe the surface of the document scanning glass plate until it is clean and dry.

4. Wipe the white document cover and the bottom side of the white sheet until it is clean and dry.

5. Close the document cover.
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10.2. Maintain the toner cartridge

It is not recommended that you take out the toner cartridge frequently during normal use of the printer. If the toner
cartridge needs to be maintained or replaced, please follow the following steps for reasonable operation.

10.2.1. Toner cartridge storage

To maximize the utilization of toner cartridges, follow the following principles:
 Do not remove the toner cartridge from the package unless it is ready for use.
 Do not refill the toner cartridge. Damage caused by the use of refilled toner cartridges is not covered by the machine

warranty.
 Store the toner cartridge in the same environment as the machine.
 In order to avoid damage, the toner cartridge should not be exposed to light for more than a few minutes.

10.2.2. Shake the toner

When the toner cartridge reaches its service life, white stripes or fading writing will appear in the printed piece. By
shaking the remaining toner in the toner cartridge. Print quality can be temporarily restored. In some cases, even after
shaking the toner, white stripes or fading of the handwriting will still appear.

1. Open the front lid.
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2. Pull the toner cartridge handle and hold it. Pull the toner cartridge out of the machine (pack the replaced toner
cartridge in a packing bag).

3 gently shake the toner cartridge 5 to 6 times to distribute the toner evenly.

Note:
 To prevent damage, the toner cartridge should not be exposed to light for more than a

few minutes. If you need to leave it in light for a few minutes, cover it with paper.
 Do not touch the green section under the toner cartridge. To avoid touching this area, use

the handle on the toner cartridge.
 If you accidentally get the toner on the clothes, wipe it with a dry cloth and wash it with

cold water, which will allow the toner to seep into the fibers of the clothes.
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4. Pull the toner cartridge handle and hold it. Insert the toner cartridge into the machine until it snaps into place.

5. Close the front cover. Make sure the front cover is closed tightly. You may make an error when printing if the cover

plate is not closed tightly.

10.2.3. Replacement of toner cartridges

Remove the old toner cartridge and install the new one. See "Installing toner cartridges" in section 2.3.

10.2.4. Clean the toner cartridge

If the printed document has stripes or spots, the OPC drum of the toner cartridge may need to be cleaned.
Wipe the OPC photosensitive drum (green part below the toner drum) with a lint-free soft cloth.

Caution:
Please be careful when inserting or pulling out the toner cartridge, do not scratch the printer.
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11. Troubleshooting

This chapter provides help information on any troubleshooting that occurs.

This chapter contains:

 Remove Paper Jam
-near the tray
-near the toner cartridge
-Near the paper output area
-near the hot melt zone
-Document Feeder (ADF) jam
-How to avoid paper jams

 Clear LCD Error Messages
 Feeder failure
 Print failure
 Scan failure
 Copy failure
 Print quality issue
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11.1. Remove paper jams

When there is a paper jam situation, the display screen appears "Paper jam! ！！Please open the face cover to clean...
"
Follow the instructions in the following section to remove jammed paper

11.1.1. Near the paper cassette

1. Gently pull the stuck paper outward to remove it.

If there is resistance when pulling the paper and the paper does not move, or the paper cannot be seen in this area,
remove the toner cartridge and check the hot melt zone near the toner cartridge.

2. Switch the front cover once to resume printing.
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11.1.2. Near the toner cartridge

1. Remove the auto-feed tray.

2. Open the front lid.

3. Pull the toner cartridge handle and hold it up gently to pull the toner cartridge out of the machine (the toner cartridge
is packed in a packaging bag).
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4. Pull the jammed paper out gently.

5. Reinstall the toner cartridge and close the front cover, and the printing work will resume automatically.

11.1.3. Near the output area

1. Switch the front cover once, and the jammed paper will automatically exit from the machine.

If you do not exit, continue with the step.

2. Gently pull the paper out of the tray.
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11.1.4. Near the hot melt zone

1. Open the scanning component (hold the gap at the bottom of the screen and lift it up slightly).

2. Open the "orange position" in the picture of the back cover, press the handle and push back slightly. (Please operate
after the machine is cooled)

Note:
The temperature near the hot melt zone is very high. Please operate the machine after cooling.
Please be careful when taking paper from the machine.
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3. Open the "red position" in the picture of the fixing cover, hold the handle and lift it up slightly. (Please operate after
the machine is cooled)

4. Pull the jammed paper out gently.

5. After removing the jammed paper, close the back cover and fixing cover.

6. Close the scanner component.

7. Switch the front cover once to resume printing.
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11.1.5. Document feeder jam

1. Open the top lid of the document feeder.

2. Carefully remove the jammed paper from the document feeder.

3. After taking out the jammed paper, close the upper cover of the document feeder, and the printer is ready
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11.1.6. How to avoid paper jams

Choosing the right paper type can avoid most paper jams. When a paper jam occurs, follow the steps outlined in Chapter
11.1, "Clear a Paper Jam."
Follow the "Put in Print Media" procedure in Chapter 2.4. Make sure the adjustable guide is in the correct position.

 Please do not fill the tray with too much paper.

 Do not remove paper from the tray during printing.

 Do not use creased, damp, or crimped paper.

 Do not mix different types of paper in the paper cassette.

 Please use the recommended print medium. See "Paper Specifications" in Chapter 3.2.

 Make sure that the recommended print side of the print medium is tray-up.

 Make sure the laser toner cartridge is installed correctly.
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11.2. Clear LCD Errors

Display content Meaning Suggested workarounds

Jam
Loaded document stuck at
auto feed end

To clear document jam, follow "Clear jam" in Chapter 11.1.

Panel is open
Front cover not closed
tightly

Close front cover until locked in place.

Fixing component
temperature abnormal

Fuser unit faulty
Unplug the power cord and plug it back in. Restart the printer,
and if the problem persists, call the service number.

Laser generator error Laser generator faulty
Unplug the power cord and plug it back in. Restart the printer,
and if the problem persists, call the service number.

Lack of paper Out of paper in tray
Load the paper into the tray. See "Loading Print Media" in
Chapter 2.4.

Jam

Paper jam in tray feeder To clear the jam, see "Near the tray" in 11.1.1.

Paper jam in toner cartridge
attachment

To clear the jam, see "Near the toner cartridge" in 11.1.2.

Paper jam occurred near the
output area

To clear paper jams, see "Near the Output Area" in 11.1.3.

Paper jam occurred in the
accessory of hot melt zone

To remove paper jams, see "Near the hot melt zone" in 11.1.4.

Document feeder jam To clear paper jams, see "Document Feeder Jam" in 11.1.5

CIS homing error
Scanner component homing
abnormal

Unplug the power cord and plug it back in. Restart the printer,
and if the problem persists, call the service number.

CIS check error
Scanner component check
abnormal

Unplug the power cord and plug it back in. Restart the printer,
and if the problem persists, call the service number.

Unknown error
An error occurred that was
not recognized by the
printer

Unplug the power cord and plug it back in. Restart the printer,
and if the problem persists, call the service number.

Scan Engine Start
Error

Failed to start scan
Unplug the power cord and plug it back in. Restart the printer,
and if the problem persists, call the service number.

Print Engine Start
Error Code

Failed to start print
Unplug the power cord and plug it back in. Restart the printer,
and if the problem persists, call the service number.

High voltage output
error

High voltage error
Unplug the power cord and plug it back in. Restart the printer,
and if the problem persists, call the service number.

System boot failed Printer Startup Failed
Unplug the power cord and plug it back in. Restart the printer,
and if the problem persists, call the service number.
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11.3. Feeder failure

Symptoms Solution
Paper jam during

printing
Remove paper jams. See "Clearing Paper Jam" in Chapter 11.1.

Paper sticks
together

Please make sure that there is not too much paper in the tray. The tray can hold up to 250
pages (70g/㎡) (depending on the type of paper used and thickness).

Make sure you are using the correct type of paper. See "Paper Specifications" in Chapter
3.2.

Remove the paper from the tray and unravel it by twisting or fanning.

Moist conditions can make some papers stick together.

No more than one
sheet of paper

Paper cassettes may be stacked with different types of paper. Be sure to load paper of the
same type, size and weight.

If a jam is caused by multiple sheets of paper, remove the jam, see "Removing Jam" in
Chapter 11.1.

No paper feed

Remove obstructions from the machine.

If the paper is not loaded correctly, take out the paper from the paper cassette, and then load
it at the right angle.

There is too much paper in the tray. Remove the excess paper from the tray.

The paper is too thick, be sure to use paper that meets the specifications required by the
machine, see "Paper Specifications" in Chapter 3.2, internal parts are faulty.

Continuous paper
jam

There is too much paper in the tray. Remove the excess paper from the tray. If printing on a
special medium, please load only one sheet at a time.

Wrong type of paper used, be sure to use one that meets the required specifications of the
machine.

There may be debris inside the machine, please open the front lid to remove the debris.

Overfeed

The printing medium contains too much static electricity (re-separating the printing medium
can eliminate part of the static electricity).

The print media is damp or glued together (please reseparate the print media or replace it
with a new print media).

Internal component failure (please reseparate the print media or replace it with a new print
media).
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11.4. Print failure

Symptoms Possible reasons Solution

Machine does not print

The machine is not powered
on

Check power cord connections, check power switches
and electrical outlets.

Machine not set as default
printer

Select your printer as the default printer in Windows.

The front cover of the printer
is not closed

Close the front cover.

Printer jam Remove paper jams. See "11.1. Clear Paper Jam."

Printer not loaded with paper Load the paper. See "2.4. Putting in Print Media."

The connection cable
between the computer and the
machine is not connected
correctly

Please reestablish the printer connection, see "2.5.
Establishing a Connection"

There is a problem with the
cable connecting the
computer to the machine

Please replace the cable.

Port Setup Error

Check the Windows printer settings to ensure that the
printing task is sent to the correct port. If your
computer has more than one port, make sure the
machine is connected to the correct port.

Machine Configuration Error
Check the printer properties to ensure that the print
settings are correct.

Printer driver not installed
correctly

To reinstall the printer software, see "5.2. Installing
Printer Driver Software with Installation Tools".

The correct printer was not
selected while printing

Select the correct printer when using an application to
print

Display prompts error
message

Please review the error message and follow the screen
prompts.

Printer is faulty
Check the display message on the Control Panel to see
if the machine is indicating a system error.

Machine selects print
media from wrong paper

source

Paper source may not be
selected correctly in printer
properties

Select the correct paper source on the Paper tab in
Printer Properties.



117Page

printing task is very slow

Host printing tasks are more Please print the multitasking job in several times.

Host is slow to transfer data Connect the printer to a host with a fast transfer speed.

Into overheat protection mode
when printing, making
printing slow

Please finish the printing task early and continue the
printing task after the printer cools down.

Half of the printed page
is blank

Paper Orientation Setting
Error

Please change the paper orientation settings.

The paper size actually used
for printing does not match
the set paper size

Make sure the paper size in the printer driver settings
is the same as the paper size in the tray.

The machine can print,
but there are text errors,
garbled or incomplete.

Loose or faulty printer cable
Please disconnect the printer cable and reconnect; Or
replace the printer cable.

Printer Device Selection
Error

Verify that you have selected the correct printer when
printing.

Software application faulty Try printing the file through another application.

Operating system faulty Restart your computer, and then try printing again.

Print page, but all blank

Toner cartridge damaged or
toner used up

Try shaking the toner. See "Shake Toner" in Chapter
10.2.2; Replace the toner cartridge if it is damaged.

There may be blank pages in
the file

Please check the file to see if there are any blank pages
in the file.

Failure of a device
component (such as a
controller or panel)

Please contact a service representative.



118Page

11.5. Scanning failure

Fault type Possible reasons Suggested workarounds

Scanner not
working

Display prompts
error message

Please review the error message and follow the screen prompts.

Scanner exposure Please make sure the scanner cover is closed properly.

USB cable failure
Please check that the USB cable is connected correctly;

Please replace the USB cable.

Scan Driver Error Please reinstall the scanner driver.

Scan
Configuration

Error

Please check that the scanner is configured correctly, check the scan
settings in the Gustec scan software configuration or the application
you want to use, and ensure that the scan job is sent to the correct port,
such as USB0001.

Insufficient
computer memory

There may not be enough memory space available to hold the
document to be scanned. You can use the preview scan feature to
check that it is working, or to reduce the scan resolution.

Display prompts
error

Please unplug the power cord, then plug back in to boot the printer,
and if the problem persists, call the service number.

Slow scanning
speed

High resolution Please reduce the scan resolution and then rescan.
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11.6. Copy failure

Fault type Possible reasons Suggested workarounds

Scanner not
working

Display prompts
error message

Please review the error message and follow the screen prompts.

Scanner exposure Please make sure the scanner cover is closed properly.

USB cable failure
Please check that the USB cable is connected correctly;

Please replace the USB cable.

Scan Driver Error Please reinstall the scanner driver.

Scan
Configuration

Error

Please check that the scanner is configured correctly, check the scan
settings in the Gustec scan software configuration or the application
you want to use, and ensure that the scan job is sent to the correct port,
such as USB0001.

Insufficient
computer memory

There may not be enough memory space available to hold the
document to be scanned. You can use the preview scan feature to
check that it is working, or to reduce the scan resolution.

Display prompts
error

Please unplug the power cord, then plug back in to boot the printer,
and if the problem persists, call the service number.

Slow scanning
speed

High resolution Please reduce the scan resolution and then rescan.
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11.7. Printing quality issues

Symptoms Suggested workarounds;

Print white or
light

If white vertical bars or faded areas appear on the page:

 With a low amount of toner, you may be able to temporarily extend the life of the toner
cartridge. See "Shaking Toner" in Chapter 10.2.2. If you still cannot improve printing
quality, install a new toner cartridge.

 Paper may not meet specifications, such as the paper being too damp or too rough. See
"Paper Specifications" in Chapter 3.2.

 If the color of the entire page is light, the print resolution is set too low.
 If fading or smudging occurs at the same time, the toner cartridge needs to be cleaned,

see "Cleaning the toner cartridge" in Chapter 10.2.4.
 The surface of the LSU parts inside the machine may be dirty. To clean the LSU, see

"Cleaning the Inside of the Machine" in Chapter 10.1.2.
 If these steps still do not resolve the problem, contact a service representative.

Toner blotch

 Paper may not meet the requirements, such as being too damp or too rough, see "Paper
Specifications" in Chapter 3.2.

 Laser toner cartridge dirty, powder leakage or laser toner cartridge damage.
 Ink transfer rollers may have stains to clean the inside of the machine, see "Cleaning the

Inside of the Machine" in Chapter 10.1.2.
 Paper feed paths may need cleaning, see "Cleaning the Inside of a Machine" in Chapter

10.1.2.
 If there are toner spots in the copying operation, it may be that the glass of the

manuscript table is dirty.

Lost word

 Uneven paper humidity or wet spots on the paper. Try using another brand of paper. See
"Paper Specifications" in Chapter 3.2.

 There is a problem with the quality of the paper. Due to papermaking process problems,
sometimes some parts of the paper may not absorb ink. Try using another type or brand
of paper.

 The toner cartridge may be faulty, see "Replacing the toner cartridge" in Chapter
10.2.3.

 If these steps still do not resolve the problem, contact a service representative.

White spot

 Uneven paper humidity or wet spots on the paper. Try using another brand of paper. See
"Paper Specifications" in Chapter 3.2.

 Laser toner cartridge damaged.
 The laser reflective glass inside the machine is dirty.
 If there are toner spots in the copying operation, it may be that the glass of the

manuscript table is dirty.
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Toner
shedding

 Paper may not meet specifications. See "Paper Specifications" in Chapter 3.2.
 The inside of the machine is dirty, clean the inside of the machine. See "Cleaning Toner

Cartridges" in Chapter 10.2.4.
 Laser toner cartridge damaged
 Damage to internal parts of machine

Black vertical
bar

If a black vertical stripe appears on the page:
 The OPC inside the toner cartridge may be scratched. Remove the toner cartridge and

install a new one.
See "Replacing Toner Cartridges" in Chapter 10.2.3.
If a white vertical stripe appears on the page:
 The surface of the LSU component inside the machine may be dirty. Clean the LSU (see

"Cleaning the Inside of the Machine" in Chapter 10.1.2) If this situation persists,
contact a service representative.

If there are toner spots in the copying operation, it may be that the table glass is dirty or the
scanning module is faulty.

Black
background
(grey bottom)

 If the background coloring situation is not good:
 For a lighter sheet, see "Paper Specifications" in Chapter 3.2.
 Check the working environment of the machine: An environment that is too dry (less

than 20% RH) or too wet (more than 80% RH) can aggravate background coloring.
 Remove the original toner cartridge and replace it with a new one, see "Replacing the

Toner Cartridge" in Chapter 10.2.3.
 If there is a black background or gray background in the copying operation, it may be

that the table glass is dirty or the upper cover of the scanner is not completely closed
during scanning.

 Print internal transfer print abnormal.
 The feed channel is dirty, clean the inside of the machine. See "Cleaning the Inside of a

Machine" in Chapter 10.1.2.

Toner trailing

 Clean the inside of the machine. See "Cleaning the Inside of a Machine" in Chapter
10.1.2.

 Check paper type and quality. See "Paper Specifications" in Chapter 3.2.
 Remove the toner cartridge and install a new toner cartridge. See "Replacing Toner

Cartridges" in Chapter 10.2.3.

Periodic
traces appear

If evenly spaced stains appear repeatedly on the print surface:
 The toner cartridge may be damaged. Remove the toner cartridge and install a new one,

see "Replacing the Toner Cartridge" in Chapter 10.2.3.
 Some parts of the machine may have toner stuck. If the stain appears on the back of the

printed page, the problem may resolve itself after printing a few more sheets.
 Fixing assembly may be damaged, please contact a service representative.
 If the paper used is of poor quality, see Chapter 10.2.4 "Cleaning Toner Cartridges".
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Background
toner

diffusion

 Background toner diffusion is formed by a small amount of toner randomly distributed
on the printed page.

 Paper may be too damp. Try to switch to another batch of paper for printing. Do not
unwrap the paper unless necessary, as it will absorb too much moisture in the air.

 If background toner spreads on the envelope, change the print layout to avoid printing
where there are overlapping seams on the back, where printing on the seams can cause
problems.

Character
distortion

 If the characters are warped and a hollow image appears, it may be because the paper is
too smooth. Try using another paper, see "Paper Specifications" in Chapter 3.2.

 If the characters are distorted and corrugated, it is possible that the scanner component
needs repair. If repairs are required, contact a service representative.

Page skew

 Make sure the paper is loaded correctly.
 Check paper type and quality. See "Paper Specifications" in Chapter 3.2.
 Ensure that the paper or other printer media is properly loaded into the tray and that the

guide board is not too tight or too loose in contact with the paper.
 The machine feed channel is dirty, clean the inside of the machine. See "Cleaning the

Inside of a Machine" in Chapter 10.1.2.

Curly or
wavy

 Make sure the paper is loaded correctly.
 Check the paper type and quality, high temperature and high humidity can cause paper to

crimp. See "Paper Specifications" in Chapter 3.2.
 Turn over the stack of paper in the tray. Or rotate the paper in the carton 180 °.

Wrinkled
paper

 Make sure the paper is loaded correctly.
 Check paper type and quality. See "Paper Specifications" in Chapter 3.2.
 Turn over the stack of paper in the tray or rotate the paper in the carton 180 °.
 Printing internal feed channel dirty. Clean the inside of the machine. See "Cleaning the

Inside of a Machine" in Chapter 10.1.2.

Dirty back

 Check if the toner is leaking or the transfer roller inside the machine is dirty. Clean the
inside of the machine. See "Cleaning the Inside of a Machine" in Chapter 10.1.2.

 The internal transfer voltage of the machine is abnormal, and the machine may need to
be repaired. Please contact a service representative.

Page All
Black

 The toner cartridge may be damaged and needs to be replaced. Remove the toner
cartridge and install a new one. See "Replacing Toner Cartridges" in Chapter 10.2.3.

 The toner cartridge may not be installed correctly. Remove the toner cartridge and
reinstall it.

 The internal charging of the machine is abnormal, the laser toner cartridge has not been
charged, and the machine may need maintenance. Please contact a service representative.

 If the copy operation is all black, it may be a scanner component failure.
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Toner
blending

 Machine Inside Dirt Clean the inside of the machine. See "Cleaning the Inside of a
Machine" in Chapter 10.1.2.

 Check paper type and quality for print media that does not meet the specifications for
use. See "Paper Specifications" in Chapter 3.2.

 Remove the toner cartridge and install a new one. See "Replacing Toner Cartridges" in
Chapter 10.2.3.

 If the problem persists and the internal parts of the machine are damaged, the machine
may need to be repaired. Please contact a service representative.

Horizontal
stripe

If there are horizontal streaks or stains of black lines:

 It may be that the toner cartridge is not installed correctly. Remove the toner cartridge
and reinstall it.

 The toner cartridge may be faulty. Remove the toner cartridge and install a new one. See
"Replacing Toner Cartridges" in Chapter 10.2.3.

If the problem persists, the internal parts of the machine may be damaged and the machine
may need to be repaired. Please contact a service representative.

Crimp

 If the printed paper is crimped or the paper cannot be fed to the printer.

 Turn over the stack of paper on the tray, please. Or rotate the paper inside the carton
180 °.
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